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Введение

[bookmark: i162][bookmark: i163][bookmark: i164]Начиная с момента своего возникновения в 1982 году фирма занималась разработкой приложений языка описания страниц Аdоbе Роstsсript и их коммерческим применением. После широкого внедрения описания стандарта РоstScript и продажи лицензии на его использование фирма сделала язык промышленным стандартом для печати электронных документов. С использованием этого языка Аdоbе и независимые фирмы, конкурирующие с компанией, разработали множество приложений, во многом способствовавших революции в издательском деле.
В качестве разработчика стандарта Adobe развила технологию переноса электронных документов между платформами, сохраняющую элементы форматирования (начертания символов, графику и другие видимые элементы), которые важны для письменных форм. Практически эти средства нашли применение, например, в программе Аdоbе Асrobat уже в 1993 году.
К системным программным пакетам фирмы относятся, помимо Аdоbе РоstSсript, Аdоbе Асrоbаt, например, программный пакет Рrерrеss.
[bookmark: i165]Adobe Асrоbаt предназначен для представления документов в одном универсальном формате, называемом Роrtаblе Dосuments Format (РDF), спецификация которого общедоступна:
· основанный на языке РоstScript, формат РDF является аппаратно независимым форматом для документов, содержащих текст, векторную и растровую графику;
· формат РDF содержит гиперсвязи, описания визуального представления текста, закладки и аннотации;
· Adobe Асrоbаt поддерживает такие средства, как Object Linking Embedding (ОLЕ), Dinamic Document Embedding (DDЕ), что обеспечивает интеграцию с другими приложениями;
· cтандарт включает средства сжатия, поддержку контекстного поиска и является первым не зависящим от платформы решением для длительного хранения электронных документов.


Продукты ADOBE

Adobe Type On Call – это диск CD-ROM, содержащий более 2000 шрифтов для заказа по телефону.
Adobe Font Folio - это Способ управления шрифтами TrueType, автоматически генерирующий отсутствующие шрифты для подстановки. Включает 30 гарнитур из библиотеки Adobe.
ATM Deluxe- Способ управления шрифтами TrueType, автоматически генерирующий отсутствующие шрифты для подстановки. Включает 30 гарнитур из библиотеки Adobe.
Adobe Type Reunion - Автоматически сортирует шрифты в семейства, что до 80 % уменьшает меню.
Adobe Illustrator - Автоматически сортирует шрифты в семейства, что до 80 % уменьшает меню.
Adobe Dimensions - Программа создания 3-D PostScript-изображений на основе кривых Безье. Позволяет сохранять файлы в формате Adobe Illustrator.
Adobe Streamline - Инструмент для преобразования битовых изображений в векторную PostScript-графику для использования в Adobe Illustrator.
Adobe PhotoShop - Мировой стандарт для работы с растровыми изображениями, ретуширования, цветокоррекции и цветоделения полутоновых и цветных изображений.
Adobe PhotoDeluxe- Простая в использовании программа для работы с растровыми изображениями, включает сотни шаблонов, изображений и фотографий.
Adobe TextureMaker - Программа для создания текстур, имитирующих природные материалы (дерево, мрамор, камень, огонь, облака).
Adobe PageMaker - Система макетирования и верстки печатных и электронных документов.
Adobe FrameMaker - Стандарт для подготовки корпоративной технической документации, объемных, часто обновляемых и сложно структурированных публикаций.
FrameMaker + SGML - Комплект, объединяющий процедуры программы FrameMaker с возможностью управления SGML-совместимыми документами.
Adobe PageMill - Инструмент создания и редактирования Web-страниц без необходимости работы с HTML-кодами напрямую.
Adobe Persuation - Программа управления серверами WWW .
 Adobe Premiere - Презентационная программа с планировщиком и готовыми шаблонами. Поддерживает печать, 35-миллиметровые слайды и проекторы .
 Adobe AfterEffects - Комплект инструментов для создания специальных эффектов в видео, анимационных и мультимедиа-проектах .
 Adobe ScreenReady - Программа преобразования Mac-документов и EPS-файлов, полученных из любых источников, в формат PICT для использования в мультимедиа-проектах.
 Adobe Acrobat - Семейство программных продуктов для межплатформенного обмена информацией, включая CD-ROM и электронное издательство .
 Adobe FrameViewer - Программа для просмотра документа FrameMaker.
 Adobe PostScript - Язык описания страниц, являющийся стандартом. Выпускается свыше 300 PostScript-продуктов .
[bookmark: i173]СРSI - это программный интерпретатор языка РоstScriрt, который позволяет абстрагироваться от конкретного контроллера печатающего устройства.
Displау РоstScriрt Level 2 выполняет те же функции, но в отношении вывода на дисплей.
Рrергеss служит для подготовки РоstScript-файлов для типографской печати и брошюрования.
[bookmark: i178][bookmark: i179][bookmark: i180][bookmark: i181]Прикладными продуктами фирмы являются системы верстки, редактирования растровой и векторной графики, видеомонтажа: РаgеМаkег, FrаmеМаker, Рhоtоshор, Illustratоr и Рrеmierе.
[bookmark: i183][bookmark: i184]Настольная издательская система РаgеМаkеr выпущена изначально фирмой Аldus, а впоследствии приобретена фирмой Аdоbе. Она отличается прежде всего универсальностью, гибкостью в работе над публикацией:
· возможность макетирования и верстки публикации с использованием текста и графики, созданных широким спектром приложений для выпуска печатных или электронных публикаций;
· простота привычного пользователям интерфейса типа «резать-клеить», быстрота перемещения элементов публикации, изменения их размера, возможность группировки, поворотов на различные углы и прикалывания к листу;
· возможность использования в одной публикации нескольких базовых страниц-прообразов;
· наличие в последних версиях возможности цветоделения и автоматического треппинга, что позволяет достичь профессиональных результатов;
· удобство работы с текстом благодаря встроенному текстовому процессору с проверкой орфографии и функциями поиска и замены;
· наличие возможности генерации содержаний и индексов;
· точное управление трекингом, кернингом и интервалами с шагом 0,1 пункта, что помогает придать тексту профессиональный вид;
· наличие самостоятельного деления изображения на составные цвета (причем неиспользуемые цвета не хранятся);
· возможность использования стандарта Коdаk Рhotо СD для изображений, записанных на компакт-диски, а также стандарта РАNТОNЕ;
· возможность поддержки ОDВС (Ореn Dаtаbаsе Соnnесtivity) при публикации баз данных;
· [bookmark: i197]наличие расширения НТМL (Hyper Text Markup Language) Аuthог, что позволяет превращать обычные публикации в гипертекст для размещения на World Wide Web (во «всемирной паутине» WWW) в формате РDF;
· наличие сетевой поддержки для групповой работы (сейчас она включает АррlеТаlk и ЕtheгТаlk (на Мас), Nоvеll и другие сети (под Windоws);
· возможность использования нескольких стандартов на предварительную печать: DСS 2.0, JРЕG, ТIFF, Sсitex СТ и ОРI;
· наличие функции просмотра расположения страницы на бумаге выбранного формата;
· возможность печати документов каждым цветом по отдельности;
· использование системы РАNОSЕ, позволяющей построить таблицу замены для отсутствующих шрифтов.
[bookmark: i203][bookmark: i205][bookmark: i206][bookmark: i207]FrаmеМаkеr, базовый продукт Frаmе Тесhnоlоgу, который в настоящее время приобретен фирмой Аdоbе. Пакет считается лучшим в области подготовки сложных многостраничных технических изданий.В соответствии с современным подходом к концепции компьютерной издательской системы (КИС) она должна быть не только средством для монтажа текста, графики, фотографий, таблиц и формул на рабочем листе, но и служить целям организации продуктивного издательского производства, удовлетворяющего нужды современного бизнеса. В настоящее время КИС должна облегчать процесс подготовки, хранения и распространения публикаций, как традиционных печатных, так и электронных. Она должна включать средства для обеспечения коллективной работы, автоматизации подготовки изданий, управления на протяжении всего жизненного цикла издания.
FrаmеМаkег отличается современным подходом для подготовки и распространения печатных и электронных публикаций, срочной верстки сложных, насыщенных формулами и таблицами документов, подготовки оригиналов-макетов бизнес-критичных изданий:
· импорт текста и графики поддерживается по ссылке или непосредственно в документ;
· содержание, глоссарии, списки литературы, списки рисунков, таблиц, приложений генерируются автоматически;
· имена стилям верстки страниц, абзацев, таблиц, символов можно задавать в рамках документа и между документами, что значительно сокращает время подготовки издания;
· условный текст позволяет хранить множество версий документа в одном файле;
· реализовано детализированное сравнение многостраничных документов с генерацией отчета;
· существуют такие возможности, как автоматическое переформатирование документа при изменении шаблонных страниц, обтекание текстом графики, поворот текста и графики на произвольно заданный угол;
· в среду FrаmеMaker интегрировано интерактивное средство для эффективного ввода, форматирования и редактирования математических формул;
· возможно пересечение текстом двух и более колонок;
· имеется встроенный в среду Frаmе удобный редактор таблиц;
· доступ ко всем функциям осуществляется через панели инструментов;
· поддерживаются цветовые модели СМYК (Cyan-Magenta-Yellow-Black), RGВ (Red-Green-Blue), НLS (Hue-Saturation-Luminance) и РАNТОNЕ;
· технология InstantView позволяет независимо от платформы просматривать созданный гипертекст без предварительной обработки;
· имеется FrаmеViеwег - самое совершенное средство управления гипертекстом на сегодняшний день;
· поддерживается коллективная работа над документом в течение всего жизненного цикла документа независимо от платформы;
· многочисленные фильтры позволяют осуществлять межплатформенный импорт и экспорт текста и графики;
· имеется Frаmе АРI, что позволяет настраивать продукт в соответствии с индивидуальными и корпоративными нуждами;
· работа FrаmеМаkег возможна во всех основных операционных средах.
Adobe photoshop.
Adobe PhotoShop – программа пиксельной графики, которая является мировым стандартом для работы с растровыми изображениями, ретуширования, цветокоррекции и цветоделения полутоновых и цветных изображений.
Программа Adobe Photoshop используется для создания, корректирования и обработки растровых изображений. С ее помощью можно корректировать фотографии, создавать коллажи и, конечно же, реализовать свои самые смелые идеи. Именно Photoshop лежит в основе красочных и ярких веб-сайтов. Кроме того, он дает возможность вносить коррекции и делать неповторимым каждое творение.


Коллаж и его создание



Коллаж - пожалуй, одна из самых популярных и распространенных техник. Ну а уж веб-дизайн в основном на коллаже и базируется. Из-за своих грандиозных композиционных возможностей он намного опережает по популярности другие виды изображений. Если в двух словах, то коллажем является некоторая совокупность отдельных элементов, "сведенных" воедино и представляющих собой нечто осмысленное. В переводе с французского языка коллаж (kollage) означает буквально следующее: комбинация разнородных предметов, наклеивание. 
1. Чтобы получить более динамичный фон, мы будем использовать два изображения. Поскольку тема нашей иллюстрации — люди в движении, то фотографии секундомера и циферблата часов будут очень кстати.

 
2. Фотография секундомера уже в достаточной степени размыта, поэтому ее мы трогать не будем. К изображению циферблата применим фильтр Box Blur с радиусом в 5 пикселов.


 
3. Выделяем целиком изображение циферблата, копируем и помещаем поверх изображения секундомера.


4. Фотографию циферблата теперь можно закрыть. В панели управления Layers изменяем режим наложения слоя на Screen и снижаем непрозрачность (Opacity) до 50%. 


 
5. Инструментом Move Tool передвигаем слой с циферблатом по своему усмотрению и кадрируем изображение инструментом Crop Tool, избавившись от ненужных пустых участков.


 
6. Объединяем оба слоя (меню Layer > Flatten Image). Поскольку режим наложения Screen создает необычные цветовые сочетания, может понадобиться их корректировка после объединения слоев. Для этого открываем диалоговое окно Selective Color (меню Image > Adjustments > Selective Color) и настраиваем цвета по своему усмотрению.


 
7. Итак, фон готов. Теперь открываем изображения людей, которые собираемся использовать для создания иллюстрации. Идеально, если фотографии сделаны на контрастном фоне — так будет легче отделить от него фигуры людей. Можно использовать как цветные, так и черно-белые фотографии.


 
8. С помощью инструмента Magnetic Lasso Tool отделяем фигуры людей от фона. Желательно взять фотографии на однородном фоне, иначе будет очень сложно отделить человека от фона.


9. Необходимо сделать контуры выделения более мягкими. Для этого для начала входим в режим быстрой маски, нажав клавишу Q. 


 
10. Применяем к изображению фильтр Gaussian Blur с радиусом размытия в 3-5 пикселов. 

 
11. Копируем выделенную фигуру и помещаем ее в новый слой нашего основного изображения.


 
12. Пока что можно не беспокоиться о масштабе и расположении фигур относительно фона — этим мы займемся после того, как все фигуры людей будут перенесены в основное изображение. Для каждой фотографии с фигурой повторяем действия, описанные выше.

 
13. Теперь начинаем постепенно располагать фигуры по своему усмотрению. Для этого, выбрав в панели управления Layers слой, передвигаем фигуру на нужное место инструментом Move Tool. 


 
14. Наметив предварительную композицию иллюстрации, займемся перемещением слоев, чтобы фигуры нужным образом перекрывали одна другую. В панели управления Layers просто меняем порядок слоев по своему усмотрению.

 
15. Теперь самое время заняться масштабом. Фигуры переднего плана необходимо оставить крупными, а более дальние сделать помельче. Для этого выбираем необходимый слой, вызываем опцию Fee Transform (Ctrl+T или меню Edit > Free Transform). Затем в строке параметров инструмента вверху экрана нажимаем пиктограмму Maintain aspect ratio и там же изменяем масштаб фигуры в процентах. 


 
16. Таким же образом изменяем масштаб остальных фигур, где это необходимо.

 
17. Наконец, можно приступить к фильтрам Blur. Сначала — фигуры переднего плана. Дублируем слой с фигурой, а к оригинальному слою применяем фильтр Motion Blur, установив параметры размытия по своему усмотрению. 


 
18. Теперь большой мягкой кистью стираем границы верхнего слоя по направлению движения размытия. В результате черты лица останутся четкими, но появится динамика. Режим наложения слоя меняем на Multiply.

 
19. Проделываем то же самое с несколькими другими (но не всеми!) фигурами, варьируя параметры размытия.


 
20. Теперь подобным же образом дублируем слои, а после размытия стирая границы верхнего слоя применяем фильтр Radial Blur к нескольким другим фигурам. 

 
21. К одной из фигур заднего плана применяем фильтр Box Blur, предварительно продублировав слой. Как и прежде, стираем границы верхнего, четкого слоя.


 
22. Сохранив последовательность действий, применяем к другой фигуре заднего плана фильтр Surface Blur, а затем стираем границы верхнего слоя.

 
23. Ну и, наконец, последняя, самая дальняя фигура. К ней применяем фильтр Gaussian Blur, также продублировав слой и стерев границы.


 
24. Последние штрихи: когда эффекты применены ко всем слоям, можно слегка подправить композицию там, где это необходимо. Инструментом Move Tool передвигаем фигуры и фон до тех пор, пока не получим нужный результат.

 
25. Можно изменить режим наложения некоторых слоев на Multiply, Overlay или Screen — это придаст изображению глубину. 


 
26. Одну из дальних фигур переводим в черно-белый режим (меню Image > Adjustments > Desaturate), предварительно объединив оба слоя (Ctrl+E).


27. В завершение в панели управления Layers объединяем все слои командой Flatten Image. И получаем динамичный коллаж, который можно отправить в печать, предварительно переведя его в формат PDF.


Заключение

С каждым годом, рынок программных продуктов для обработки изображений постоянно расширяется. Новые продукты предлагают решение некоторых проблем, но программа Adobe Photoshop удовлетворяет требования потребителей уже свыше двадцати лет, а постоянные обновления и улучшения предполагают, что эта тенденция продолжится и в будущем.
Последние версии продукта предлагают неограниченные возможности для работы не только с растровой графикой, но и с трехмерными изображениями. Таким образом, теперь даже люди, занимающиеся анимацией смогут пользоваться программой для решения своих проблем. Кроме того, в последней версии есть инструменты, позволяющие редактировать DVD, но это еще не все. Добавлен новый инструмент Pixel Bender, с помощью которого стало возможным добавление специальных эффектов.
Одно из самых главных преимуществ графического редактора Photoshop в том, что использование этого программного продукта не может затруднить потребителей. Удобный интерфейс помогает даже новичкам быстро освоить программу и максимально использовать возможности.
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